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1 Úvod

V tomto textu jsou shrnuty základńı operace, funkce a principy práce v Matlabu a
Simulinku, tak jak jsou vyžadovány na cvičeńıch předmětu Modelováńı systémů a pro-
ces̊u, přednášeného v letńım semestru třet́ıho ročńıku. Pochopeńı ukázkových př́ıklad̊u
a samostatné zvládnut́ı neřešených pak stanovuje požadovanou mı́ru znalost́ı nutných
pro splněńı praktické části zápočtu. Ned́ılnou součást́ı textu jsou odkazy na doporučená
skripta [1].

2 Matlab

Matlab je programový systém společnosti The MathWorks, Inc. Název souboru je zkratka
”MATrix LABoratory” a výstižně charakterizuje zp̊usob práce s programem. Původně
Matlab sloužil jako interface na metody numerických knihoven LINPACK a EISPACK.
Později se stal komerčńım produktem a pro svou jednoduchost se stal pr̊umyslovým
standardem v oblasti softwarových řešeńı automatického ř́ızeńı (CADCS).

2.1 Přednosti Matlabu

T́ım, že se Matlab stal světovým standardem v mnoha inženýrských oborech, je rozš́ı̌ren
po celém světe a existuje pro všechny operačńı systémy (Unix, Linux, Solaris, Windows,
Mac OS). Matlab je možno relativně pohodlně rozšǐrovat o daľśı funkce a na Inter-
netu je možné źıskat několik deśıtek toolbox̊u. S programem je možné zač́ıt pracovat i
bez speciálńıch znalost́ı programováńı (nicméně, elementárńı znalosti programováńı jsou
výhodou). V systému Matlab jsou zabudovány robustńı numerické metody. Matlab je
možné dále rozšǐrovat o exterńı programy (MEX-soubory) naprogramované v C/C++
nebo Fortranu.

2.2 Př́ıkazy a proměnné

Př́ıkazy jsou v Matlabu ve tvaru proměnná = výraz. Výrazy se skládaj́ı z operátor̊u,
speciálńıch znak̊u, funkćı a proměnných. Pokud chyb́ı přǐrazeńı proměnné, zavede se
systémová proměnná ans. Umı́stěńım středńıku za výrazem potlač́ıme výstup na ob-
razovku. Mezery uvnitř výrazu jsou nepodstatné. Výsledkem je obecně matice, která
se zobrazi na obrazovce. Jména proměnných a funkćı muśı zač́ınat ṕısmenem. Matlab
rozlǐsuje malá a velká ṕısmena ve jménech proměnných, funkćı a konstant.

Př́ıklad:

>> 1320 / 63

>> ans =

20.9524

>> a = 1 + 1;

>> a = a + 1

>> a =

3
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2.3 Č́ısla a aritmetické výrazy

Matlab provád́ı všechny výpočty v dvojité přesnosti (pokud neńı definováno jinak). Pri-
orita operaćı je stejná jako v matematice. Okolo symbol̊u e,E nesmı́ být mezera (např.
3.14159, 6.6345e23, 9.12E-20). V Matlabu je možné použ́ıvat následuj́ıćı operátory:

+ sč́ıtáńı,

- odč́ıtáńı,

* násobeńı,

/ pravé děleńı,

\ levé děleńı,

∧ umocňováńı

() závorky upravuj́ı pořad́ı prováděńı operaćı.

2.4 Manipulace s maticemi a vektory

2.4.1 Generováńı vektoru

Vektor v Matlabu zadáváme výčtem prvk̊u nebo definićı prvku vektoru na dané pozici
(kapitola 2.4.3). Pro generováńı vektoru lze také použ́ıt notaci s dvojtečkou. Syntaxe je:
vektor = od : <krok> : do. Tento zp̊usob je vhodný pro zápis aritmetických posloup-
nost́ı. Transpozici vektoru provedeme takto: u = u’.

Př́ıklad:

>> u = [1 2 3 4 5] % výčet prvků

>> x = 1:5 % notace s dvojtečkou

>> x =

1 2 3 4 5

>> y = 0:pi/4:pi

>> y =

0.0000 0.7854 1.5708 2.3562 3.1416

Cvičeńı 1:
1. Definujte vektor ~a, který obsahuje prvky 3, 4, 5, 6, 7, 8.
2. Definujte vektor ~a, který obsahuje prvky 8, 7, 6, 5, 4, 3.
3. Definujte vektor ~a, který obsahuje pouze sudá č́ısla od 1 do 20.

2.4.2 Generováńı tabulky

Př́ıklad:

>> x = [0.0:0.1:0.5]’;

>> y = exp(-x).*cos(x);

>> [x y]

>> ans =

0 1.0000
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0.1000 0.9003

0.2000 0.8024

0.3000 0.7077

0.4000 0.6174

0.5000 0.5323

Cvičeńı 2:
1. Nadefinujte vektory ~u,~v, ~w stejné délky a vytvořte z nich tabulku, kde v prvńım
sloupci bude vektor ~u, ve druhém ,~v, a ve třet́ım ~w.
2. Vytvořte tabulku, goniometrických funkćı od −2π do 2π.

2.4.3 Čteńı a zápis prvku vektoru na dané pozici

K prvk̊um vektoru v Matlabu přistupujeme pomoćı index̊u, podobně jako v jiných pro-
gramovaćıch jazyćıch. Na vektor se můžeme d́ıvat jako na alokované pole, které má na
rozd́ıl od jiných programovaćıch jazyk̊u prvńı index roven 1 a ne 0. Vektor můžeme tedy
deklarovat i t́ım, že definujeme prvky na jednotlivých pozićıch.

Př́ıklad:

>> a(1) = 1; a(3) = 5; a(7) = 3;

>> a

>> ans =

1 0 5 0 3

Čteńı hodnoty vektoru na dané pozici provedeme obdobně přǐrazeńım.

Př́ıklad:

>> u = [1 3 5 7];

>> x = u(2)

x =

3

2.4.4 Generováńı matice

Matice v Matlabu vytvář́ıme obdobně jako vektory. Výčtem prvk̊u, př́ıpadně zápisem
hodnoty prvku na danou pozici. Hodnoty matice čteme opět obdobně jako u vektor̊u.
Prvńı index je řádkový, druhý index sloupcový.

1. Odkaz na konkrétńı prvek matice

>> a(3,3) = a(1,3) + a(3,1);

2. Definice matice (5,1), která se skládá z prvk̊u A(1,3), A(2,3), . . . , A(5,3)

>> A(1:5,3);

3. Definice matice (5,4), která se skládá z prvńıch pěti řad a sloupc̊u 7 až 10 matice A
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>> A(1:5,7:10);

4. Všechny prvky 3. sloupce matice A

>> A(:,3);

5. Nahrazeńı 2., 4. a 7. sloupce matice A prvńımi třemi sloupci matice B

>> A = [1 2 3 4 5 6 7 8 9; ...

1 2 3 4 5 6 7 8 9; ...

1 2 3 4 5 6 7 8 9];

>> B = [0 0 0 13 13; ...

0 0 0 13 13; ...

0 0 0 13 13];

>> A(:,[2 4 7]) = B(:,1:3)

>> A =

1 0 3 0 5 6 0 8 9

1 0 3 0 5 6 0 8 9

1 0 3 0 5 6 0 8 9

6. Prohozeńı sloupc̊u matice A

>> A = A(:,9:-1:1);

>> A =

9 8 0 6 5 0 3 0 1

9 8 0 6 5 0 3 0 1

9 8 0 6 5 0 3 0 1

7. Převod matice na vektor

>> A = [1 2; 3 4; 5 6];

>> B = A(:)’

>> B =

1 3 5 2 4 6

8. Prázdná matice. Prázdná matice x=[] má nulový rozměr. Vymazáńı 1. a 3. sloupce
matice A se tedy provede

>> A(:,[1 3]) = [];

Cvičeńı 3:
1. Je dán vektor ~u = {9 11 13 · · · 97}T . Jak tento vektor nejefektivněji zadáte.
2. Zadejte matici A, s dimenźı 8× 7, která má všechny prvky nulové, pouze prvky [1, 4]
a [4, 6] jsou rovny 1.
3. Zadejte libovolnou matici A. Jak vytvoř́ıte vektor ~u, který bude obsahovat všechny
prvky druhého sloupce matice A.
4. Zadejte libovolné matici A a B se stejnou dimenźı. V matici A nahrad’te prvńı sloupec,
posledńım sloupcem matice B.
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2.4.5 Komplexńı č́ısla a matice

Komplexńı č́ısla jsou povolena ve všech operaćıch a funkćıch Matlabu. Pokud i nebo j
použ́ıváme jako proměnné, je třeba nadefinovat jinou imaginárńı jednotku, např.

>> ii = sqrt(-1);

>> z = 2 + 3*ii;

Zápis matice s komplexńımi prvky se tedy provád́ı:

>> A = [1 2;3 4] + i*[-5 6; 7 -8];

>> A = [1-5*i 2+6*i; 3+7*i 4-8*i];

2.4.6 Operace s maticemi

Zápis matic je obdobný jako v matematice. Základńı operace s maticemi jsou:

1. Transpozice B = A’

>> A = [1 2;3 4]

>> A =

1 2

3 4

>> B = A’

>> B =

1 3

2 4

2. Součet a rozd́ıl. Matice muśı mı́t stejný rozměr (m,n) + (m,n) = (m,n)

>> C = A + B;

>> C = A - B;

3. Součin. Matice muśı mı́t př́ıslušný rozměr (m,n)∗(n, k) = (m, k). Jedná se o vektorový
součin, jehož výsledkem je skalár.

>> C = A * B;

4. Pod́ıl. V Matlabu rozlǐsujeme pravé děleńı C = A/B, které je definováno A*inv(B) a
levé děleńı C = A\B, definovené inv(A)*B. Pravé děleńı je také možné definovat jako B/A

= (A’\B’)’.

5. Umocňováńı C = A∧p, resp. C = p∧A je definováno, pokud A je čtvercová matice a p

skalár.

2.5 Operace s poli

Tyto operace odpov́ıdaj́ı operaćım ”prvku s prvkem”. Operace jsou stejné jako s mati-
cemi. Jedná se o tyto operátory: .’ .* .\ ./ .∧
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Př́ıklad:

>> x = [1 2 3], y = [4 5 6];

>> z = x .\ y

>> z =

4.0000 2.5000 2.0000

>> z = x .^ y

>> z =

1 32 729

Cvičeńı 4:
1. Zadejte matici A a B. Jak provedete vektorový součin? Jaké muśı být dimenze matice
A a B?
2. Od všech prvk̊u matice A odečtěte konstantu 3.
3. Je dán vektor ~u = {1 3 5 7} a vektor ~v = {2 4 6 8}T . Jak vypočtete součin vektoru ~u
a vektoru ~v. Jak by součin vypadal v př́ıpadě operace ”prvek s prvkem”.

2.6 Relace

Relace je možné provádět mezi maticemi stejných rozměr̊u. Porovnáńı je prováděno mezi
odpov́ıdaj́ıćımi si prvky. Výsledkem je matice samých 0 a 1. Hodnota 1 odpov́ıdá pravdivé
relaci, hodnota 0 nepravdivé. Relačńı operátory jsou:

< menš́ı než,

<= menš́ı nebo rovno,

> větš́ı než,

>= větš́ı nebo rovno,

== rovno,

∼= nerovno,

Př́ıklad:

>> x = [1 4 8], y = [-4 5 0];

>> x < y

>> ans =

0 1 0

Cvičeńı 5:
1. Je dána matice A=[1 2 3; 4 5 6; 1 2 3]. Jak zjist́ıte, zda jsou hodnoty prvk̊u v
prvńım řádku matice A menš́ı než hodnoty prvk̊u ve třet́ım sloupci matice A. Zapǐste
výsledek této operace.
2. Je dán vektor ~u = {1 2 3}. Výsledkem operace ~u 6= ~v je vektor {1 0 1} . Jak zadáte
libovolný vektor ~v, který odpov́ıdá zadané operaci.
3. Je dán vektor ~u = {2 2 3} a vektor ~v = {1 2 1}. Napǐste relačńı operátor, pomoćı
kterého zjist́ıte, zda je vektor ~u roven vektoru ~v. Zapǐste výsledek této operace.
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2.7 Logické operace

Logické operace lze provádět mezi maticemi stejných rozměr̊u. Logické operace jsou
prováděny mezi prvky matic, které jsou obvykle 0 nebo 1. Logické operátory jsou:

& konjunkce (AND),

| disjunkce (OR),

∼ negace (NOT),

V Matlabu jsou zabudovány ještě daľśı relačńı a logické funkce, např. any, all.

2.8 Řetězce

Řetězce jsou uzavřeny v apostrofech a ukládány jako vektory.

Př́ıklad:

>> x = ’modelovani’

>> x =

modelovani

>> x = [x, ’ systemu a procesu’]

>> x =

modelovani systemu a procesu

>> size(x)

>> ans =

1 27

2.9 Informace o proměnných

Informace o proměnných a alokované paměti udávaj́ı funkce who a whos. Alokované
proměnné je možné uložit do souboru a později nač́ıst k daľśımu zpracováńı pomoćı
funkćı save a load. Vymazáńı proměnné provád́ı př́ıkaz clear.

Př́ıklad:

>> x = [1 2 3; 4 5 6; 7 8 9]

>> x =

1 2 3

4 5 6

7 8 9

>> save moje_matice.mat x;

>> clear;

>> load moje_matice.mat;

>> x

>> x =

1 2 3

4 5 6

7 8 9
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2.10 Help

Matlab obsahuje velmi kvalitńı nápovědu v HTML a PDF. Často je mnohem efektivněǰśı
použ́ıt zabudovaný help, který poskytuje dostatek informaćı o všech objektech Matlabu.

Př́ıklad:

>> help plot

2.11 Funkce v Matlabu

Matlab má v současné době několik stovek interńıch funkćı. Mezi ty nejd̊uležitěǰśı (a na
cvičeńıch nejpouž́ıvaněǰśı) patř́ı:

Obecné funkce

help on-line nápověda
who seznam proměnných
size dimenze matice
length délka vektoru
∧C ukončeńı výpočtu
chdir změna adresáře
save uložeńı proměnné do souboru
load načteńı proměnné ze souboru
clear de-alokace proměnných

Matematické funkce
Goniometrické a ostatńı matematické funkce jsou definovány stejně jako v matematice
(např. sin, cos, sqrt, exp).

Ostatńı funkce

clc vymaže obrazovku
echo zobraźı komentář
plot grafický výstup
ones(m,n) jednotková matice (m,n)
zeros(m,n) nulová matice (m,n)
rand(m,n) matice (m,n) náhodných č́ısel
roots výpočet vlastńıch č́ısel

Funkce jsou bud’ vnitřńı, nebo se jedná o tzv. M-funkce, které jsou uloženy na disku.
Uživatel může vytvářet vlastńı M-funkce (pomoćı př́ıkaz̊u Matlabu, nebo pomoćı mex-
funkćı naprogramovaných jazykem C) a t́ım rozšǐrovat funkčnost Matlabu.

Funkce mohou mı́t v́ıce vstupńıch a výstupńıch parametr̊u. Př́ıklad zápisu funkce s
jedńım výstupńım parametrem je y=sin(x). Funkce však může vracet i v́ıce parametr̊u
(např. [m,n]=size(X)).
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2.12 Grafické funkce

Visualizace dat je silnou stránkou Matlabu. Základńı operace s grafy jsou velmi jedno-
duché a snadno zapamatovatelné. Pokročileǰśı práce s grafy, jejich nastaveńı a export
do r̊uzných grafických formát̊u je možné nalézt v nápovědě. Základńı př́ıkaz pro tvorbu
graf̊u je plot. Tento př́ıkaz vykresĺı čárový graf, který spojuje body se souřadnicemi
[x, y]. Souřadnice jsou definovány vektory x a y.

Př́ıklad:

>> t = pi*(0:0.02:2);

>> plot(t,sin(t))

O tom, že se jedná skutečně o čárou spojené body se můžete přesvědčit př́ıkazem

>> plot(t,sin(t),’o-’)

Pokud nyńı necháme vykreslit červenou barvou funkci cos(t),

>> plot(t,cos(t),’r’)

předchoźı křivka bude vymazána. Pro přidáńı křivky do již existuj́ıćıho grafu použijeme
př́ıkaz hold.

Př́ıklad:

>> plot(t,sin(t),’b’)

>> hold on

>> plot(t,cos(t),’r’)

Mezi daľśı užitečné př́ıkazy pro práci s grafy patř́ı např́ıklad:

Př́ıkaz Funkce
figure otevře nové grafické okno
subplot v́ıce graf̊u v jednom grafickém okně
semilogx, semilogy, loglog logaritmické měř́ıtko osy x a y
legend legenda pro grafy s v́ıce funkcemi
print tisk na tiskárně

Tabulka 1: Daľśı funkce pro tvorbu graf̊u

Př́ıklad:

>> t = 2*pi*(0:0.01:1);

>> plot(t,sin(t))

>> xlabel(’t’)

>> ylabel(’amplituda’)

>> title(’Jednoduchý harmonický oscilátor’)

Obdobně jako vykreslujeme grafy funkćı y = f(x) (2D grafy), můžeme v Matlabu tvořit
grafy funkćı y = f(x, y) (3D grafy).

11



Př́ıklad:

>> x = pi*(0:0.02:1);

>> y = 2*x;

>> [X,Y] = meshgrid(x,y);

>> surf(X,Y,sin(X.2+Y))

Grafické výstupy Matlabu můžeme nejen zobrazovat na obrazovce, tisknout na tiskárně,
ale i ukládat do soubor̊u pro daľśı použit́ı v jiných (např. publikačńıch) programech.
Graf, jako obrázek, ulož́ıme př́ıkazem saveas(figure,jmeno). Podporovány jsou tyto
grafické formáty – bitmapové GIF, JPEG, PNG, TIFF, BMP a vektorové EPS a WMF.
Obrázek je ukládán do právě použ́ıvaného adresáře.

Př́ıklad:

>> figure(1)

>> t = pi*(0:0.02:2);

>> plot(t,sin(t))

>> saveas(1,’sinus.bmp’);

2.13 M-soubory (M-files)

Př́ıkazy Matlabu jsou prováděny bud’ ihned (v command window) nebo mohou být
uloženy do m-souboru, do textového souboru s př́ıponou .m, a prováděny sekvenčně.
Př́ıkazy m-souboru se mohou odkazovat na jiné m-soubory, př́ıpadně rekurzivně volat
sami sebe. M-soubory jsou typu script nebo m-funkce.

2.13.1 Script soubory

Scriptové soubory jsou sekvencemi př́ıkaz̊u ve kterých jsou všechny proměnné globálńı.

Př́ıklad:

x = [-pi:0.1:pi]’;

y = sin(x);

plot(y)

2.13.2 M-funkce

M-funkce rozšǐruj́ı možnosti Matlabu, protože umožňuj́ı definovat nové funkce. Pro-
měnné jsou uvnitř funkce lokálńı a s prostřed́ım Matlabu komunikuj́ı pomoćı vstupńıch
a výstupńıch parametr̊u. Nová funkce se definuje př́ıkazem function a seznamem vstup-
ńıch a výstupńıch parametr̊u (bez tohoto př́ıkazu by se jednalo o script soubor).
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Př́ıklad:

function y=prumer(x)

% vstupni parametr vektor x

% vystupni parametr aritmeticky prumer

% pouziti y=prumer(x)

y=0;

soucet=0;

for i=1:length(x)

soucet=soucet+x(i);

end

y=soucet/length(x);

2.13.3 Mex-funkce

Z Matlabu lze volat i exterńı funkce napsané v jazyćıch C nebo Fortran. Funkce napro-
gramovaná v jazyce C se skládá ze dvou část́ı. Prvńı, tzv. gateway interface, zajǐstuje
komunikaci s Matlabem a je obdobou main() funkce v jazyce C. Druhá část je vlastńı
kód. Výhodou mex funkćı je jejich mnohonásobně vyšš́ı rychlost oproti m-funkćım.

2.14 Programováńı M-soubor̊u

Při programováńı m-soubor̊u je často požadováno opakované prováděńı skupiny př́ıkaz̊u.
V př́ıpadě, že je počet opakováńı dán, je vhodné použ́ıt př́ıkaz for.

for <parametr>=<vyraz>

<prikazy>

end

Př́ıkazy cyklu se mohou vkladat do sebe, každý př́ıkaz for je ukončen př́ıkazem end.

Př́ıklad:

for i=1:m

for j=1:n

x(i,j)=0;

y(i,j)=0;

end

end

V př́ıpadě, že počet opakováńı neńı předem dán, je možné použ́ıt př́ıkaz while. Sku-
pina př́ıkaz̊u je prováděna tolikrát, dokud je splněna logická podmı́nka.

while <podminka>

<prikazy>

end
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Př́ıklad:

n=1;

while prod(1:n) < 1000

n=n+1;

end;

Př́ıkaz if umožňuje větveńı programu podle logické podmı́nky.

if <podminka>

<prikaz>

elseif <podminka>

<prikaz>

...

else

<prikaz>

end

Př́ıklad:

j=a;

for i=1:n

if X(i,j)>0

m=m+1;

elseif X(i,j)<0

m=m-1;

else

break;

end

end

Př́ıkaz break umožňuje přerušit prováděńı for nebo while cykl̊u. Př́ıkaz return předá
ř́ızeńı volaj́ıćı funkci, př́ıpadně umožńı návrat do command window. Př́ıkaz input umožňuje
vstup dat z obrazovky.

<promenna> = input(’<text>’[,’s’])

Př́ıklad:

jmeno=input(’Vase jmeno:’,’s’);

rok=input(’Rok narozeni:’);

Př́ıkaz eval interpretuje znakový řetězec.
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Př́ıklad:

string=’clc,clear,a=[1 2;3 4],...

b=[0 0; 1 0], c=a*b’

eval string

a =

1 2

3 4

b =

0 0

1 0

c =

2 0

4 0

2.15 Koeficienty Čebyševových polynomů

Čebyševovy polynomy mohou být odvozeny takto:

Necht’ x = cos(ϕ), |x| ≤ 1 a předpokládejme, že existuj́ı polynomy Tk(x) = cos(kϕ), cos(ϕ) =
x. Řešeńım diferenciálńı rovnice, pro |x| ≤ 1,

(1− x2)y′′ − xy′ + n2y = 0, y = Tn(x), n ≥ 0 (1)

dostaneme tyto polynomy:

T0(x) = 1, (2)

T1(x) = x,

T2(x) = 2x2 − 1,

T3(x) = 4x3 − 3x,

T4(x) = 8x4 − 8x2 + 1,

T5(x) = 16x5 − 20x3 + 5x . . . ,

Tyto polynomy splňuj́ı rekurentńı rovnici

T0(x) = 1, (3)

T1(x) = x,

Tk+1(x) = 2xTk(x)− Tk−1(x), k = 1, . . . , n,

Model v Matlabu

function F=T(n)

% *************************************

% * Koeficienty Cebysevovych polynomu *

% * *

% *************************************

pocitadlo = 1;
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arg = [1 0];

a = [1];

b = [1 0];

shift = [0 0 1];

if n == 0

F = a;

elseif n == 1

F = b;

else

while pocitadlo < n

c = conv(2*arg,b) - conv(shift,a);

a = b;

b = c;

pocitadlo = pocitadlo + 1;

end

F = c;

end

2.16 Jednoduchý dynamický model Nab́ıdka-Poptávka

Vyjděme z ekonomického modelu, kdy nab́ıdka v n-tém časovém intervalu s(n) je př́ımo
úměrná ceně produktu v minulém časovém intervalu p(n−1) a naopak poptávka v n-tém
časovém intervalu dem(n) klesá se současnou cenou produktu p(n), to znamená, že je
úměrná −dp(n). Zavedeme-li proměnnou u(n), která charakterizuje počet vyrobených
kus̊u v čase n, můžeme systém popsat soustavou tř́ı diferenčńıch rovnic.

s(n) = c · p(n− 1) + a · u(n), (4)

dem(n) = −d · p(n) + b · u(n),

s(n) = p(n).

Pro obecně zvolené parametry a, b, c, d a u(n) = 1(n) můžeme v Matlabu vytvořit
následuj́ıćı model.

Model v Matlabu

% ********************************

% * Nabı́dka a poptávka *

% * (jednoduchý dynamický model) *

% ********************************

clear

a = 100;

b = 120;

c = 3;

d = 4;

N = 50;

% vstupnı́ posloupnost

u = ones(1,N);
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p(1) = (b-a)/d;

% rovnice pro cenu p(n)

for k = 2:N

p(k) = -c/d*p(k-1)+(b-a)/d*u(k);

end

figure(1)

subplot(3,1,1), stem(p)

% nabı́dka s(n)

for m = 1:N

s(m) = c*p(m) + a*u(m);

end

subplot(3,1,2), plot(p,s,’*’)

% poptávka dem(n)

for m = 1:N

dem(m) = -d*p(m) + b*u(m);

end

subplot(3,1,3), plot(p,dem,’o’,p,s,’*’)

3 Simulink

Simulink, součást Matlabu, je nástroj pro modelováńı a analyzováńı dynamických systé-
mů. Podporovány jsou lineárńı i nelineárńı systémy, spojité i diskrétńı modely, př́ıpadně
jejich kombinace.

3.1 Úvod do Simulinku

Modelováńı prob́ıhá v grafickém uživatelském prostřed́ı (GUI) převážně pomoćı myši.
Model se skládá z blokových diagramů, které v tomto prostřed́ı vytvář́ıme obdobně, jako
bychom je kreslili tužkou na paṕır.

Součást́ı Simulinku je obsáhlá knihovna r̊uzných vstup̊u, výstup̊u, lineárńıch a ne-
lineárńıch komponent a konektor̊u umožňuj́ıćıch spojovat jednotlivé bloky. Stejně jako v
př́ıpadě Matlabu je možné vytvářet vlastńı bloky (vytvářeńım subsystémů z existuj́ıćıch
blok̊u, př́ıpaně naprogramováńım nových blok̊u v jazyce C pomoćı S-funkćı).

Po vytvořeńı modelu je možno z integrovaného menu spustit jeho simulaci. Použit́ım
výstupńıch blok̊u je možné zobrazovat, měnit parametry a analyzovat výsledky během
simulace. Stejně tak je možné ukládat výsledky do proměnných Matlabu a dále je zpra-
covávat, př́ıpadně použ́ıt pro vizualizaci. Protože Simulink je integrován v Matlabu, je
možné simulovat, analyzovat a upravovat modely v obou prostřed́ıch.

3.1.1 Spuštěńı Simulinku

Okno pro vytvářeńı model̊u (viz obrázek 1) v Simulinku otevřeme pomoćı menu
File→New→Model,
knihovnu stavebńıch blok̊u (viz obrázek 2) pak zobraźıme z tohoto okna pomoćı
View→Library browser.
Alternativně lze téhož efektu dosáhnout př́ıkazem simulink z př́ıkazové řádky Matlabu
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(v mém př́ıpadě tento př́ıkaz ovšem pouze otevře okno s knihovnou stavebńıch blok̊u
Simulinku).

Obrázek 1: Okno pro kreslńı modelu v Simulinku

Obrázek 2: Knihovna stavebńıch blok̊u pro Simulink
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3.1.2 Jednoduché př́ıklady

Nejjednodušš́ı př́ıklad: zobrazeńı funkce sin(t) pomoćı bloku zdroje Sine Wave a bloku
výstupu Scope. Vyzkoušejte si ovládáńı parametr̊u blok̊u: nastaveńı délky periody, na-
staveńı amplitudy, nastaveńı fáze, automatické zobrazeńı celého grafu v př́ıpadě, že
překračuje implicitně nastavené meze.

Jak pomoćı zdroje Sine Wave źıskám funkci cos(t)? Pomoćı bloku Mux zobrazte oba
dva pr̊uběhy v jednom grafu. Zobrazte součet sin(t) + cos(t), zobrazte násobek dvou
funkćı.

3.1.3 Kružnice

Vyzkoušejte si, co se stane při použit́ı bloku výstupu XYGraph a dvou vstup̊u Sine Wave,
z nichž jeden simuluje funkci sin(t) a druhý funkci cos(t). Proč je výstupem simulace
jednotková kružnice?

Cvičeńı 6:
Namodelujte systém zobrazuj́ıćı rovnici kružnice s poloměrem r, danou rovnicemi

x = r sin t

y = r cos t

Cvičeńı 7:
Namodelujte systém zobrazuj́ıćı logaritmickou spirálu

x = e−kt sin t

y = e−kt cos t

Jak byste nasimulovali systém generuj́ıćı obraz archimedovy spirály, př́ıpadně asteroidy?
Asteroida je popsána soustavou rovnic

x = sin3 t

y = cos3 t

a Archimedova spirála je popsána soustavou

x = t sin t

y = t cos t

3.1.4 Parametry simulace

Pokud se vám v předchoźıch př́ıkladech zobrazovaly jenom podivné hranaté tvary, ni-
jak nepřipomı́naj́ıćı to, co jste předpokládali, že uvid́ıte, je to patrně t́ım, že simulace
prob́ıhala bud’ př́ılǐs krátce, nebo byl časový krok simulace př́ılǐs velký.

Okno pro nastaveńı parametr̊u simulace (viz obrázek 3) lze otevř́ıt bud’ klávesovou
zkratkou Ctrl+E nebo z menu v okně modelu pomoćı volby Simulation→Simulation

parameters....
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Obrázek 3: Nastaveńı parametr̊u simulace

V tomto okně můžete nastavit, jestli simulace prob́ıhá s proměnným časovým krokem,
či s krokem pevným, a parametry časového kroku – počátečńı krok (tedy hodnotu, s
ńıž simulace zač́ıná), minimálńı a maximálńı časový krok (pro simulaci s proměnným
časovým krokem). Volbou položek Start time a Stop time voĺıte délku doby simulace.
Vyzkoušejte si to.

3.1.5 Nab́ıdka-poptávka

V př́ıkladu 5.2 na stranách 99–100 je ukázán model ekonomického systému vývoje ceny
na základě nab́ıdky a poptávky. Ve skriptu se tento př́ıklad řeš́ı pomoćı Z-transformace,
ale na obrázku 5.12 můžete vidět model p̊uvodńı diferenčńı rovnice, z ńıž model vycháźı
(viz též odvozeńı rovnice (2.8) na straně 14). Ve skriptu znázorněný model poč́ıtá s
pevnými hodnotami – upravte jej pro uživatelem zadané hodnoty parametr̊u a, b, c a d.

3.1.6 Fakulta

Základńı model předpov́ıdaj́ıćı počet student̊u absolvuj́ıćıch studium např́ıklad na FD
ČVUT je opět popsán ve skriptu v př́ıkladu 5.3 na stranách 100–103. Upravte tento
model tak, aby zohledňoval fakt, že po nedokončńı prvńı etapy studia něktř́ı studenti
konč́ı, a že do každého vyšš́ıho ročńıku mohou přistoupit studenti z jiných škol.

3.2 Modelováńı v Simulinku

Většinu podklad̊u nalezenete ve skriptech [1]. Ćılem této kapitoly je seznámit vás s mo-
delováńım jednoduchých dynamických systémů popsaných vněǰśım a vnitřńım popisem.

Pro samostudium doporučujeme kapitoly 3.3 (stránky 54–59), a v nich probrané
př́ıklady a př́ıklady 5.4 a 5.5 na stranách 103–105.

3.2.1 Integrátor a jednotkové zpožděńı

Při simulaci spojitých systémů využ́ıváme bloku Integrator, jenž, jak jeho název na-
pov́ıdá, integruje vstupńı signál v čase. Funkci bloku demonstruje jednoduché schéma
znázorněné na obrázku 4. Přivedeme-li na vstup integrátoru signál a(t), bude výstup
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tohoto bloku odpov́ıdat signálu
∫

a(τ)dτ , a obráceně: je-li na vstupu da(t)
dt

, na výstupu
bloku bude a(t).

y'(t) y(t)

Step
Scope

1
s

Integrator

Obrázek 4: Jednoduchý př́ıklad ukazuj́ıćı funkci integrátoru.

Při simulaci diskrétńıch systémů pak využ́ıváme bloku Unit Delay, jenž vzorkuje
vstupńı signál každou celou časovou jednotku simulace a navzorkovanou hodnotu v čase
o jednotku zpozd́ı – to, co jsme přivedli na vstup toto bloku v okamžiku t = ν nalezneme
na výstupu tohoto bloku až v čase n = ν+1 a tato hodnota bude na výstupu pro všechna
n < ν + 2. Funkci bloku demonstruje schéma znázorněné na obrázku 5. Přivedeme-li na
vstup integrátoru signál a(n), bude výstup tohoto bloku odpov́ıdat signálu a(n − 1), a
obráceně, je-li na vstupu a(n + 1), na výstupu obdrž́ıme a(n).

y(n)
respektive
y(n+1)

y(n-1)
respektive

y(n)
z
1

Unit Delay ScopePulse
Generator

Obrázek 5: Jednoduchý př́ıklad ukazuj́ıćı funkci bloku Unit Delay,

3.2.2 Diferenciálńı rovnice

Vytvořme jednoduchý model systému popsaného diferenciálńı rovnićı prvńıho řádu

y′(t) + a · y(t) = sin(t). (5)

Celou rovnici nejprve přeṕı̌seme tak, aby na levé straně byla nejvyšš́ı derivace, v tomto
př́ıpadě y(t),

y′(t) = sin(t)− a · y(t),

vzhledem k tomu, že rovnice muśı platit i při modelováńı, muśı být rozd́ıl veličin u(t) a
a · y(t) roven derivaci y′(t). Pr̊uběh y(t) ovšem neznáme – lze jej ale źıskat pomoćı in-
tegrátoru z vypočtené derivace, kterou máme na výstupu. Výsledné schéma je na obrázku
6.

Cvičeńı 8:
Zkuste si stejným zp̊usobem vytvořit schéma k rovnici

y′′′(t) + b · y′′(t) + a · y(t) = sin(t). (6)
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Sum

Sine Wave

1
s

Integrator
a

Gain

y'(t)
      sin(t)

a y(t)y(t)

Obrázek 6: Simulačńı schéma pro rovnici (5).

3.2.3 Diferenčńı rovnice

Mějme systém popsaný diferenčńı rovnićı

y(n− 1) + a · y(n) = u(t). (7)

Před modelováńım si opět rovnici můžeme upravit na

y(n) =
1

a
[u(t)− y(n− 1)] .

a pomoćı bloku Unit Delay z y(n) vyrob́ıme y(n − 1). Výsledek pro u(t) = t je na
obrázku 7.

Sumz
1

Unit Delay

Scope

1/a

Gain

Clock
u(n)-y(n-1)

      u(n)

y(n-1)

y(n)

Obrázek 7: Simulačńı schéma pro rovnici (7).

Cvičeńı 9:
Zkuste si nyńı samostatně namodelovat obdobný systém, popsaný rovnićı:

y(n + 1) + a · y(n) = 1(t). (8)

3.2.4 Vnitřńı popis systému

Doposud jsme se zabývali modely systémů popsaných vněǰśım popisem. V některých
př́ıpadech je ovšem lepš́ı použ́ıt vnitřńı popis. Obrázek 8 ukazuje model diskrétńıho
systému popsaného soustavou

x2(n) = bx1(n−1) + cx2(n−1) + u2u(n)

x1(n) = ax1(n−1) + u1u(n) (9)

y(n) = y1x1(n) + y2x2(n)
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Sine Wave

Scopey2
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y1

Gain6

c
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a

Gain4

u2

Gain3

u1

Gain2

b

Gain1

   a*x1(n-1)
x1(n-1)

      u(n)

x2(n-1)

x2(n)

x1(n)

y(n)

Obrázek 8: Model vnitřńıho popisu systému podle soustavy (9).
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Řešeńı Matlab

Cvičeńı 1:
1. Definujte vektor ~a, který obsahuje prvky 3, 4, 5, 6, 7, 8.
>> a = [3 4 5 6 7 8]

>> a = 3:8

2. Definujte vektor ~a, který obsahuje prvky 8, 7, 6, 5, 4, 3.
>> a = [8 7 6 5 4 3]

>> a = 8:-1:3

3. Definujte vektor ~a, který obsahuje pouze sudá č́ısla od 1 do 20.
>> a = 2:2:20

Cvičeńı 2:
1. Nadefinujte vektory ~u,~v, ~w stejné délky a vytvořte z nich tabulku, kde v prvńım
sloupci bude vektor ~u, ve druhém ,~v, a ve třet́ım ~w.
>> u = [1 0 0 1]

>> v = [1 1 1 1]

>> w = [1 0 1 0]

>> T = [u’ v’ w’]

2. Vytvořte tabulku, goniometrických funkćı od −2π do 2π.
>> t = -2*pi:0.1:2*pi;

>> s = sin(t);

>> c = cos(t);

>> Tabulka = [t’ s’ c’]

Cvičeńı 3:
1. Je dán vektor ~u = {9 11 13 · · · 97}T . Jak tento vektor nejefektivněji zadáte.
>> u = 9:2:97

2. Zadejte matici A, s dimenźı 8× 7, která má všechny prvky nulové, pouze prvky [1, 4]
a [4, 6] jsou rovny 1.
>> A = zeros(8,7)

>> A(1,4) = 1;

>> A(4,6) = 1;

>> A

3. Zadejte libovolnou matici A. Jak vytvoř́ıte vektor ~u, který bude obsahovat všechny
prvky druhého sloupce matice A.
>> A = [1 2 3 4; 1 1 1 1; 2 2 2 2];

>> u = A(:,2)

4. Zadejte libovolné matici A a B se stejnou dimenźı. V matici A nahrad’te prvńı sloupec,
posledńım sloupcem matice B.
>> A = [1 2 3 4; 1 1 1 1; 2 2 2 2];

>> B = [1 1 1 1; 0 0 0 0; 1 1 1 1];

>> A(:,1) = B(:,4);

>> A
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Cvičeńı 4:
1. Zadejte matici A a B. Jak provedete vektorový součin? Jaké muśı být dimenze matice
A a B?
>> A = [1 2 3; 1 2 3];

>> B = [1 2; 3 4; 5 6];

>> s = A * B

(m,n)*(n,k)=(m,k), výsledkem operace je skalár

2. Od všech prvk̊u matice A odečtěte konstantu 3.
>> A = [1 2 3 4; 1 1 4 4; 4 4 4 4];

>> A = A - 3;

3. Je dán vektor ~u = {1 3 5 7} a vektor ~v = {2 4 6 8}T . Jak vypočtete součin vektoru ~u
a vektoru ~v. Jak by součin vypadal v př́ıpadě operace ”prvek s prvkem”.
>> s = u * v’

>> S = u .* v

Cvičeńı 5:
1. Je dána matice A=[1 2 3; 4 5 6; 1 2 3]. Jak zjist́ıte, zda jsou hodnoty prvk̊u v
prvńım řádku matice A menš́ı než hodnoty prvk̊u ve třet́ım sloupci matice A. Zapǐste
výsledek této operace.
>> A(1,:)<A(:,3)’

>> ans =

>> 1 1 0

2. Je dán vektor ~u = {1 2 3}. Výsledkem operace ~u 6= ~v je vektor {1 0 1} . Jak zadáte
libovolný vektor ~v, který odpov́ıdá zadané operaci.
např.

>> v = [5 2 5]

3. Je dán vektor ~u = {2 2 3} a vektor ~v = {1 2 1}. Napǐste relačńı operátor, pomoćı
kterého zjist́ıte, zda je vektor ~u roven vektoru ~v. Zapǐste výsledek této operace.
>> u == v

ans =

0 1 0
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Řešeńı Simulink

Cvičeńı 6:
Namodelujte systém zobrazuj́ıćı rovnici kružnice s poloměrem r, danou rovnicemi

x = r sin t

y = r cos t

r
r*sin(t)

r
r*cos(t)

XY Graph

Sinus

Cosinus

Obrázek 9: Kružnice o poloměru r.

Cvičeńı 7:
Namodelujte systém zobrazuj́ıćı logaritmickou spirálu

x = e−kt sin t

y = e−kt cos t

r(t)*sin(t)

r(t)*cos(t)

eu

exp(-k*t)

XY Graph

Sinus

Cosinus

Clock
-k
-k*t

r(t)

Obrázek 10: Logaritmická spirála.

Cvičeńı 8:
Zkuste si stejným zp̊usobem vytvořit schéma k rovnici

y′′′(t) + b · y′′(t) + a · y(t) = sin(t). (10)
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Sum

Sine Wave

1
s

Integrator3

1
s

Integrator2

1
s

Integrator1
a

Gain2

b

Gain1

y'''(t)

      sin(t)

a y(t)y(t)y'(t)

b y''(t)

Obrázek 11: Model systému popsaného rovnićı (10).

Cvičeńı 9:
Zkuste si nyńı samostatně namodelovat obdobný systém, popsaný rovnićı:

y(n + 1) + a · y(n) = 1(t). (11)

Sumz
1

Unit Delay

Sine Wave

Scope

a

Gain

y(n+1)

      sin(n)

a y(n)y(n)

Obrázek 12: Model systému popsaného rovnićı (11).
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Jan Přikryl
Lístek s poznámkou
Toto je chyba, buď má být na vstupu blok "Step" nebo v rovnici (11) musí být místo "1(t)" napsáno "sin(t)",




